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Pharmacokinetic Case Study Hydromorphone IV Kinetics 

 
Hydromorphone Kinetics Following an Intravenous 

Bolus Injection: the Two-Compartment Model 
 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 

• How to obtain initial parameter estimates for a two-compartment model. 
• How to write the equations for the noncompartmental parameters. 
• How to evaluate the area under the curve. 
• How to investigate different two-compartment model structures. 

 
Data Required 
 

The data file for this case study is 
 

hydromorphone.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
This case study will show you how to analyze data that are decaying biexponentially 
following a bolus injection of drug into plasma. It will show you how to obtain initial 
estimates for the model parameters. The equations for the noncompartmental model 
parameters will also be written. In addition, you will have the option to explore different 
structures for the two-compartment model and see which of the parameters change. 
 
The data come from a study of hydromorphone kinetics1. Hydromorphone is a 
semisynthetic opiate agonist, similar in structure to morphine. It is used as an alternative 
to morphine for treating pain in cancer patients because it can be prepared for parenteral 
administration in more concentrated aqueous solutions and is about seven times more 
potent than morphine. Hydromorphone dosing is usually intravenous (iv), intramuscular 
or subcutaneous; in this study, the dosing is iv.  
 
1 Hill, H.F., Coda, B. A., Tanaka, A. and Schaffer, R. “Multiple-dose evaluations of 

intravenous hydromorphone pharmacokinetics in normal human subjects.” Anest. 
Analg. 1991, 72:330-336. 
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Part 1. Develop a two-compartment model for hydromorphone kinetics. 

The first step will be to investigate the data and postulate a two-compartment model to 
describe the data following an iv bolus injection.  
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. In the SAAM II Toolbox, be sure the Model tools are 
available. 

 
2.  Investigate the data. 
 

The first step in any new model development process should be to investigate the 
data. This will give you an idea as to how many compartments will be needed. 
For example, if you plot your data following a bolus, and in semilog mode they 
appear as a straight line, then a single compartment will probably be adequate. If, 
on the other hand, they appear to decay at least biexponentially, then at least two 
compartments will be needed. 
 
a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file hydromorphone.dat should appear in 

the list (if it does not, find the folder where you put the data file). 
 
c. Double-click hydromorphone.dat. The data file contains the plasma 

hydromorphone data following the bolus injection into plasma. The Data 
window will appear (in part) as follows: 
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The weighting scheme is FSD so you can leave the variance model set as the 
default, data-relative.  
 
If you scroll through the Data window, you will see that the dose for the iv 
bolus is entered as a constant using CONST. In addition, if you scroll to the 
end of the window, you will find the equations for the noncompartmental 
parameters entered as comments. You will use these equations later in the 
case study. 
 

 Entering comments in a Data file. You can enter comments in your data file if 
you precede each line with “#.” In this data file, comments are provided which 
give information on the dose and units of the data. As noted, the 
noncompartmental parameter equations are also provided. 

 
 

d. Close the Data window. 
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3. View your data using a line plot. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Experiment Attributes dialog box will open. 
 

(1) Enter “300” in the End At box. The Experiment Attributes dialog box 
will appear as follows: 

 

 
 

(2) Click Done. The Plot and Table Variables dialog box will open. 
 

 Experiment attributes. Normally you are used to seeing the Experiment 
Attributes dialog box when you switch from the Model to the Experiment 
tools. In this situation, no model has been created, so SAAM II does not know 
the duration of the experiment. When you try to plot your data, SAAM II must 
know when the experiment ends. For this reason, the Experiment Attributes 
dialog box opens at this point in the model building process. 

 
 

b. The List All Variables check box is selected. The reason the box is selected 
is because there are no samples specified yet. 

 
c. Click plasma to move it to the Current Selection pane. 
 
d. Click Done. A plot of the plasma data will appear in the Plot window. 
 
e. In the View menu, click Line Plot. 
 
f. In the View menu, click Semilog.  
 
g. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
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h. In the Y Axis pane, enter  “1” in the Minimum box, and “60” in the 
Maximum box. The Plot and Table Scale dialog box will appear as follows: 

 

 
 
i. Click Done. The following plot will appear: 
 

 
 

 Line Plots. Using the line plot in semilog mode to connect your data can help 
you decide how many exponentials (compartments) will be needed for the 
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model. In this case, it is clear that at least two exponentials or compartments 
will be needed.  

 
It is also important to note that the first datum is at about 1 minute, and there 
are 4 samples by 5 minutes. 

 
 If these data had not been collected, i.e. if the first sample were drawn after 5 

minutes, the data would appear to decay monoexponentially, and the 
researchers would have lost the valuable information concerning the rapid 
initial distribution of the drug. While initial mixing is always a problem, it is 
important to collect early samples if one wants to elucidate the details of the 
initial distribution of a drug, especially if this phase is very rapid which is the 
case here. 

 
 

j. Close the Plot window. 
 

  Based on the above observations, the two-compartment model will be used to 
analyze these data. Create the following system model on the Drawing Canvas: 

 

 
 
Part 2. Create the pharmacokinetic experiment on the model 

 
1. In the SAAM II Toolbox, click Experiment. Notice that the Experiment 

Attributes dialog box does not open. This is because the attributes were specified 
when you did your line plot. However, the Create Experiment dialog box will 
appear on the Drawing Canvas. The choice of experiment Types is an 
Experiment or a System. Experiment is selected. 
 
a. Enter “hydromorphone” in the New Name box. The Create Experiment 

dialog box will appear as follows: 
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b. Click Create.  
 

  Experiment vs. System. The Create Experiment dialog box is where you 
create your experiment. There are two types of experiments - “Experiment” 
and “System”. 
 
The Experiment type will invoke SAAM II’s differential equation machinery. 
When you create this type of experiment, your compartmental model will be 
interpreted by SAAM II as a system of differential equations. Once parameter 
values and inputs have been specified, SAAM II can Solve the system of 
differential equations, and can Fit your model to your data. This type of 
experiment is designed to deal with time dependent data following an 
experimental (exogenous) input into the system.  
 
The System experiment creates a system of algebraic equations whose 
coefficients are the k(i,j) of your compartmental model. The System model is 
used primarily in tracer-tracee experiments to describe the tracee data in the 
steady-state. 
 

 The default New Name is “Exper”. This can be changed to a name of your 
choice. 

 
 

3. Create a sample on Compartment 1. 
 

a. In the SAAM II Toolbox, click Sample. 
 

b. Click Compartment q1, and then click on the Drawing Canvas. The sample 
s1 will appear. 

 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “ng/ml” in the Units box. 
 
e Type “plasma” in the Associate with Data Name box. (Notice “plasma” is in 

lower case.) 
 
f Edit the sample equation “s1=q1” to read “s1=q1/vol” in the Equations box. 

The Samples Attributes dialog box will appear as shown below: 
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g Click Done. 

 
4. Create an input into Compartment 1. 

 
The dose of hydromorphone was 1504 mg. Since the units of the data are in 
ng/ml, the dose must be consistent with the data. Thus the dose is 1,504,000 ng. 
As described above, the dose is entered as a constant in the data file, and hence 
the input will be written as an equation. 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 

c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Be sure equation is selected as the input type. In the Equation pane, type 

“ex1=dose”. 
 
e. In the Event Start box, enter “0”. 
 
f. In the Event Stop box, enter “0”. 
  
g. Click Add. The Exogenous Input dialog box will appear as follows: 
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h. Click Done. Your model will appear as follows: 
 

 
 

 Equation input. It is frequently the case that one would like have the dose 
specified in the data file. This can be done in SAAM II using the CONST 
feature. Constants such as doses can be entered in this way. To create the 
bolus input equal to the dose, you write the input as a equation equal to the 
constant dose. The bolus is created by making the start and stop time equal. 

 
 
Part 3. Defining Derived Variables (Noncompartmental parameters). 
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The parameters for your model are the rate constants k(2,1), k(1,2), k(0,1)  and the 
volume vol. These are called the primary parameters. The rate constant k(0,1) is a 
fractional measure of the elimination rate of the drug, and it has units of inverse time (in 
this case, 1/hour).  
 
From these parameters, the equations for the noncompartmental parameters can be 
written. For example, the clearance is defined as 
 

Cl = k(0,1) * vol 
 
Clearance Cl is a derived variable, as it is a function of the primary parameters k(0,1) and 
vol. As you recall, parameters are variables that appear in the equations characterizing the 
model or experiment, but were not given numerical values. SAAM II automatically 
determines the model parameters. Following a successful “fit,” the optimal values and 
statistical information about their precision appear in the Statistics window. In addition, 
the statistical information about the derived variables appears in the Derived Variables 
pane. 
 
Besides clearance, there are a number of other noncompartmental pharmacokinetic 
parameters that can be estimated from the two-compartment model with a bolus injection 
into plasma. These are 
 

Cmax=dose/vol 
half_time=log(2)/k(0,1) 
r=sqrt((k(2,1)+k(1,2)+k(0,1))^2-(4*k(1,2)*k(0,1))) 
alpha=(k(2,1)+k(1,2)+k(0,1)+r)/2 
beta=(k(2,1)+k(1,2)+k(0,1)-r)/2 
A=(dose/vol)*((alpha-k(1,2))/(alpha-beta)) 
B=-(dose/vol)*((beta-k(1,2))/(alpha-beta)) 
AUC=dose/(vol*k(0,1)) 
AUMC=(A/alpha^2)+(B/beta^2) 
Syst_MRT=AUMC/AUC 
MRT_Cpt1=1/k(0,1) 
Cl=dose/AUC 
Vss=Cl*Syst_MRT 

 
Included in this list are the parameters characterizing the solution of the system of two 
differential equations represented by the two-compartment model. More specifically, the 
solution s1 can be written: 
 
 s1=A*exp(-alpha*t)+B*exp(-beta*t) 
 
If you were to fit a sum of two exponentials to these data, you would obtain the above 
values for A, B, alpha and beta. 
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Notice also that there are two residence time calculations. Syst_MRT is the mean 
residence time in the system, i.e. the average time a hydromorphone particle spends in the 
system before being irreversibly lost. MRT_Cpt1 is the average time a hydromorphone 
particle spends in plasma. 
 
You can enter these parameters directly. For convenience, they can be cut and pasted 
from the Data file to the Equations dialog box as described below. 
 

1. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, click 

Data . The Data window will open. 
 
2. Scroll down through the Data window until all the noncompartmental parameters 

are available. Select and copy the noncompartmental parameters. The selected 
information will appear in the Data window as follows: 

 

 
 
3. Close the Data window. 
 
4. In the Show menu, click Equations, or alternatively, on the SAAM II Toolbar, 

click Equations . The Equations dialog box will open. 
 
5. Paste the equations in the Equations Defined Here pane in the Equations dialog 

box. 
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6. Remove the “#” from in front of each equation. The Equations dialog box will 

appear as follows: 
 

 
 

 Equation syntax. There are two points to remember about equation syntax in 
SAAM II. First, while it may be appealing to define half time as t_1/2, this is 
improper syntax, and SAAM II will display an error message. The other point 
is that the natural log is “log,” not “ln.” If you define, for example, 
t_half=ln(2)/k(0,2), “ln(2)” will be interpreted as a parameter instead of an 
algebraic operation and will appear as a parameter in the Parameters dialog 
box. 

 
 
7. Close the Equation dialog box. 
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Part 4. Enter the parameter values, solve the model, fit the model to data, view the 
solution and record the results. 

 
Before you can Solve (simulate) your model or Fit your model to your data, you must 
provide numerical estimates for the primary parameters of your model. These are the 
parameters that appear in the Parameters dialog box. 
 

1. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameter . The Parameters dialog box will open.  
 
b. If k(0,1) is not selected, double-click k(0,1) to select it. Enter “0.033” in the 

Value box and click Save. 
 
c. Double-click k(1,2). Enter “0.05” in the Value box and click Save. 
 
d. Double-click k(2,1). Enter “0.45” in the Value box and click Save. 
 
e. Double-click vol. Enter “16710” in the Value box and click Save. The 

Parameters dialog box will appear as follows: 
 

 
 

f. Click Done. 
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 Initial parameter estimates. How to obtain the initial estimates for the 
parameters is explained in the Appendix 1 to this case study. How these 
estimates are obtained applies to any experiment in which you are using a 
two-compartment model following a bolus injection of a drug. 

 
 

2. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 

b. In the View menu, select Model Labels and click Values. Your model will 
appear as follows: 

 

 
 

 Model labels. Model Labels gives you three options to label the transfers in 
your model. One is the name, k(i,j) which is the default label. The other is 
Values; this labels the transfers with their current values. In the event that a 
transfer is non-linear, the current value is the zero time value. The final option 
is no label at all. Labeling with the parameter value is useful since it lets you 
know the current value of each parameter without having to open the 
Parameters dialog box. 

 
 

c. Plot the data. In the Show menu, click Plot, or alternatively, on the SAAM II 

Toolbar, click Plot . Since you have previously plotted the data, the plot 
of the data will appear.  

 
d. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. Be sure the List All Variables check box is cleared. 

©University of Washington Hyrdomorphone - 14 Rev. 08/10/01 



Pharmacokinetic Case Study Hydromorphone IV Kinetics 

 
e. Click s1:plasma to move it to the Current Selection pane. 

 
f. Click Done. If your plot does not appear in semi-log mode, in the View menu, 

click Semilog. Your plot will appear as follows: 
 

 
 

The initial estimate for the parameters are reasonable, so you can proceed to 
Fit your model to your data. 

 
g. Leave the Plot window open. 

 
3. Fit your model to your data and view the solution and the statistics. 

 
a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click, Fit . Your model will be updated as follows: 
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b. Since your Plot window is already open, your plot will be updated and appear 

as follows: 
 

 
 

The “fit” is satisfactory in that there are no obvious systematic deviations 
between the model predictions and the data. 
 

c. In the Show menu, click Statistics, or alternatively, on the SAAM II Toolbar 

click, Statistics . The Statistics window will open as follows: 
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You can see that the statistics are quite reasonable in that no parameter has a 
large error. You will have to scroll through the Parameter/Variable pane to 
see all of the pharmacokinetic noncompartmental parameters. 

 
4. Record the results in the Notes window (optional). 
 

You may record the results of your modeling exercise using the Notes window if 
you wish. You may also omit this part of the case study since the contents of the 
Notes window are included as Appendix 2. 
 
If you do not do this part of the case study, close the Statistics and Plot windows 
before proceeding. If you do this part of the case study, leave these windows 
open. 
 
a. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar 

click Notes . The Notes window will open. 
 
b. Type the text “Fit of two-compartment model to data with loss from 

Compartment 1.” 
 
c. In the Statistics window, select all the information for all the parameters.  
 
d. In the Edit menu, click Copy. 
 
e. Click in the Notes window to make it the current window. In the Edit menu, 

click Paste. Add the titles to the columns (e.g. value, SD, Coeff of Var, etc.) 
 
f. In the Statistics window, select the information for the objective function. 
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g. Click in the Notes window. Click below the statistical information. In the Edit 

menu, click Copy. Your Notes window should appear as follows: 
 

 
 

 Two or three compartments? At this point, you have successfully fit the two- 
compartment model to your data, and estimated the primary parameters and 
the noncompartmental parameters. How do you know the two-compartment 
model is the appropriate model? In this case, if you try to add a third 
compartment, you will find that the three-compartment model is not supported 
by these data. This will be revealed when you see that the two new rate 
constants cannot be estimated. Thus you are safe in concluding that the two-
compartment model is appropriate. 

 
 

h. Close all windows. 
 
Part 5. Estimate areas under the curves. 
 
One is often interested in the “area under the curve.” This usually refers to the area under 
the plasma concentration-time curve. Sometimes, however, it is useful to obtain other 
areas such as areas under the different compartments qi in the model or functions of the 
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area under the plasma concentration-time curve such as the first-moment, or “mean” area 
under the curve. 
 
In this part of the case study, SAAM II’s ability to compute the area under a curve will be 
discussed. This will show you how to evaluate any of the areas you wish. 
 
Under normal circumstances, you probably will not have the noncompartmental 
equations defined. In this case, you do, so as a reference point, remember that the AUC 
calculated above is 2321.12 with a standard deviation of 8.1. This will allow you to 
compare SAAM II’s calculations with those obtained from the noncompartmental 
equations. 
 

1. Estimate the area under the concentration-time curve (s1) using the Compute 
Sample AUC’s feature in SAAM II. 

 
a. In the Compute menu, click Settings. The Computational Settings dialog 

box will open. 
 

 Computational Settings. In order to open the Computational Settings dialog 
box, all other windows and dialog boxes must be closed. 

 
 
b. Select the Compute Sample AUC’s check box. The Computational Settings 

dialog box will appear as follows: 
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c. Click Done. 
 
d. Solve your model. 
 
e. In the Show menu, click AUC’s. The Area Under Curve window will open 

as shown below: 
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 Using the Compute Sample AUC’s feature in SAAM II. To use the Compute 
Sample AUC’s feature in SAAM II, you have to select this option in the 
Computational Settings window. The calculated AUC values can be viewed 
by clicking AUC’s in the Show menu. 

 
 You will notice two things about the value returned above. First, it is equal to 

1573 which is less than the value you calculated previously which was 2321. 
Second, there is no statistical information. 

 
 The reason why the value for the AUC is less than 2321 is that when you 

calculate sample AUC using the Compute Sample AUC’s feature in SAAM 
II, the value calculated will be the value at the end of the experiment, in this 
case 300 minutes. Thus to estimate the true AUC, you need to extend the time 
of the experiment until the area under the tail portion of the curve is 
negligible. A rule of thumb is to set the end of the experiment equal to 100 
times the inverse of the smallest rate constant. Here the smallest rate constant 
is k(0,1) which is 0.037. The inverse is 27, and 100 times that is 2700 minutes. 
To be sure you are close to the true AUC, you should double that number to 
see if there is a difference in AUC; if there is, you must continue to double the 
duration of the experiment until the difference in AUC values is small. 

 
 The reason why there are no statistics is that you have not fitted your model to 

the data. When you fit your model to your data, statistics on the AUC will be 
returned. 

 
 
f. Close the Area Under Curve window. 
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g. Change the time of the experiment. 
 

(1) In the Set menu, click Experiment Attributes. The Experiment 
Attributes dialog box will open. 

 
(2) Change the End At time from “300” to “2700”. 
 
(3) Click Done. 
 

h. Re-Solve the model, and view the AUC. The value now is 2321.0 which is 
essentially identical to the one obtained using the model parameters. 

 
i. Change the End At time of the experiment from “2700” to “5400”. Re-Solve 

the model and view the AUC. The AUC is now 2321.1; the difference 
between integrating to 2700 and 5400 is 0.1 so it is safe to stop. 

 
j. Fit the model to your data, and view the AUC. The Area Under Curve 

window will appear as follows: 
 

 
 

 When you Fit your model to your data, you will obtain an estimated standard 
deviation for the AUC. 

 

 Area under the curve calculation. It may appear somewhat cumbersome to 
evaluate the area under the curve using this method. It requires a few steps to 
be sure that you have integrated long enough to obtain the total area. The 
advantage of this method, however, is that you can obtain the area up to any 
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time you wish simply by changing the time the experiment ends. Thus you can 
investigate, for example, the time at which the area has reached a certain 
percentage of its total area. 

 
 
k. Close the Area Under Curve window. 
 

2. Estimate the area under q2. 
 
 In order to estimate the area under q2, the solution of the differential equation 

q2’(t), you must first put a sample on it. Then when you Solve or Fit, the area will 
be automatically calculated. 

 
a. Put a sample on q2. Your model will appear as follows: 
 

 
 

b. Solve your model, and view the AUC. The Area Under Curve window will 
appear as follows: 

 

 
 

 Notice that there are no statistics; this is because you "Solved,” not ”Fitted,” 
your model to your data. 
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c. Fit the model to the data, and view the AUC. The Area Under Curve window 

will appear as follows: 
 

 
 

d. Close the Area Under Curve window. 
 
3. Estimate area under the first moment curve, AUMC. 
 
 The area under the first moment curve, or the mean area under the curve, is 

needed to estimate some of the noncompartmental parameters such as the system 
mean residence time. To estimate AUMC, you need to create a new sample as 
follows. 

 
a. Create a sample on Compartment q1. Sample s3 will be created. 
 
b. Open the Sample Attributes dialog box, and edit the sample equation to read 

“s3=t*s1”. The Sample Attributes dialog box will appear as follows: 
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c. Click Done. You will notice s3 is no longer connected to q1; this is because 

q1 does not appear in the sample equation. 
 

 

 Estimating AUMC. In SAAM II, the compute area under the curve option will 

calculate  where t∫
endt

dttsi
0

)( end is the time at which the experiment ends (and 

set by the user - this is what you changed so that  would 

approximate .) When you write the sample equation s3 = t*s1, you 

are approximating  which is exactly AUMC. 

∫
endt

dttsi
0

)(

∫
∞

0
)( dttsi

∫ ⋅
endt

dttst
0

)(1

 
 

d. Fit the model to the data, and view the area under the curve calculations. The 
Area Under Curve window will appear as follows: 

 

 
 

 Because of the way in which s3 was defined, the AUC for s3 is actually the 
AUMC for the concentration-time curve. The value for s3, the AUMC, is 
612110 with a standard deviation of 51697. These values compare favorably 
with the values calculated originally of 612,400 with a standard deviation of 
51,737. These values are very close; the differences have to do with what is 
called round-off error in the numerical calculations. 
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e. (Optional) Copy the contents of the Area Under Curve window and paste the 
information in the Notes window. If you do not do this part, reset the time of 
the experiment to 300, and delete samples s2 and s3. Re-Solve the model. 

 
Open the Notes window. Title the section “SAAM II AUC calculations.” 
Copy and pasate the contents of the Area Under Curve window into the 
Notes window. This part of your Notes window will appear as follows: 

 

 
 
f. Close the Notes and Area Under Curve windows. Reset the time of the 

experiment to 300, and delete samples s2 and s3. Re-Solve the model. 
 

If you wish, you may save the study file for future use. It is recommended you Save the 
SAAM II study file as Two_Compartment_Template. You may proceed to Part 6 
which is optional. Otherwise, Quit the SAAM II Compartmental application. The 
contents of the Notes window are contained in Appendix 2 (Appendix 2 also contains the 
notes from the next part of this case study.) 
 

 The two-compartment model template. You can use this as a template for the 
two compartment model where, following a bolus injection of drug iv, you 
want to estimate both the model parameters and noncompartmental 
parameters. You will need to provide the new data and initial parameter 
estimates; the model’s equations do not change. 

 
 
Part 6.  Explore different structures for the two-compartment model - a priori 

identifiability (optional). 
 
To explore different structures for the two-compartment model, you need first to remove 
the noncompartmental equations from the Equations dialog box. 
 

1. Remove the noncompartmental equations from the Equations Defined Here pane 
in the Equations dialog box. The Equations dialog box will appear as follows: 
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2. Modify your system model by adding a loss k(0,2). Your model should appear as 

follows: 
 

 
 

 Your model now has five parameters instead of the original four. 
 
3. Open the Parameters dialog box, and enter the initial values as shown below: 
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4. Solve the model, and view the solution. When you do, you will see that the model 
predicted values are decaying more rapidly than the data. Change k(0,1) to 0.01 
and k(0,2) to 0.005. When you re-solve the model, it is still decaying a little too 
fast. You can continue hand-fitting the model to the data if you wish. 

 
5. Fit the model to the data. When you do, you will get a warning message as shown 

below: 
 

 
 

 As the warning implies, k(0,1) has hit a lower limit. If you change the Low Limit 
for k(0,1) and fit again, you will get the same warning message. You can 
continue, but it is clear that k(0,1) is heading towards zero. 
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 The reason is that you cannot estimate the five parameters in the model from the 
data; this model is a priori nonidentifiable as explained in Appendices 1 and 3.  

 

 Warning messages. Warning messages in SAAM II are designed to help you 
in your modeling exercise when the program detects a problem. In this case, 
when a parameter hits a limit, it can mean either that you are near a solution 
and have to adjust the limit, or your parameter cannot be estimated from the 
data. When the same warning message appears time after time when you 
change a limit, it is a good sign you will not be able to estimate all model 
parameters, and will have to resort to alternative strategies. 

 
 In this particular situation, it is possible to get a warning message that the 

covariance matrix is unreliable, and no statistical information is available. 
This warning results again from the fact that, as noted above, there are more 
parameters in the model than can be estimated from the data. 

 
 

6. Open the Parameters dialog box, set k(0,2) equal to zero, and fix it. Reset the 
low and high limits for k(0,1). The Parameters dialog box will appear as follows: 

 

 
 

7. Fit the model to the data. You will get a warning that k(0,1) hit an upper limit. 
Adjust the upper limit, and fit the model again. As a rule of thumb, you can 
double the limit. In this case, you can double the upper limit, but the low limit 
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will remain unchanged. If your upper limit increases substantially from your 
original estimate, you should readjust your low limit also so that the high limit is 
about 10 times greater than the value and the low limit is about 0.1 times the 
value. You should obtain a successful fit. View the statistics - you will see they 
are identical to your first successful fit because, with k(0,2) equal to zero, the 
model is the same as the original model. 

 
8. (Optional) Open the Notes window, and add the statistics from the last Fit. Enter 

the title “Best fit of model with k(0,2) = 0.” This part of your Notes window will 
appear as follows: 

 

 
 

Close the Notes window. 
 
9. Fix k(0,1) and Re-Solve the model. 
 

a. Open the Parameters dialog box. 
 
b. Set k(0,1) equal to zero, and fix it. 
 
c. Set k(0,2) adjustable, and enter 0.01, 0.001 and 0.1 as the Value, Low Limit 

and High Limit respectively. 
 
d. Close the Parameters dialog box. 
 

10. Fit the model to the data.  
 

If you plot the results, you will see that the “Fit” is identical to your previous 
“Fit” where k(0,2) was zero. If you look at your parameter values, you will see, in 
comparing the two cases with first k(0,2) = 0 and then k(0,1) = 0, that the 
exchange rate constants are different, but the value of the objective function is 
essentially the same. You have obtained an identical solution, one with the loss 
from compartment 1, and the other with the loss from compartment 2! 
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If you wish, you may record the results in the Notes window as you did above, 
otherwise you may proceed to step 11. If you record you results,  title this part 
“Best fit of model with k(0,1) = 0.” This part of the Notes window will appear as 
follows: 

 

 
 

Close the Notes window. 
 
11. Perform a series of “Fits” with k(0,2) fixed at different values. To do this, set 

k(0,1) as adjustable with an initial estimate of 0.02. You can pick any value for 
k(0,2) between 0 and 0.0039. Try three examples with k(0,2) fixed at the 
following values: 

 
 k(0,2) = 0.001 
 k(0,2)=  0.002 
 k(0,2)=  0.003 
 
 You will see that in each case you obtain a “Fit” that is identical to the others, and 

that the value for the objective function is essentially the same for all of the 
“Fits.” 
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12. Set k(0,2) equal to 0.006, and fit the model to the data. As you lower the Low 
Limit on k(0,1), you will get a series of warnings that k(0,1) has hit the low limit. 
It wants to go to zero. Set k(0,1) equal to zero (remember biology prevents k(0,1) 
from becoming negative). When you fit the model to the data, you will not obtain 
a good fit. 

 

 Interval identifiability. This two-compartment model, the model with the two 
exchange rate constants and two losses, is called interval identifiable. This 
means that while there may be an infinite number of solutions, i.e. you can set 
k(0,2) to an infinite number of values, these values must lie within certain 
bounds to obtain a good “fit” of the model to the data. Interval identifiability 
is described in Appendix 3 for the two-compartment model. It is sometimes 
the case that, even though the full two-compartment model is not identifiable, 
the intervals in which the parameters lie provide valuable information. 

 
 
13. Introducing fixed parameter constraints. 
 
 Suppose that in this situation, you know that the full two-compartment model was 

appropriate to analyze these pharmacokinetic data. You have just learned that you 
cannot estimate all five parameters. As you have seen, if you have precise 
knowledge about one parameter, you can fix it, and obtain a good fit (assuming 
that your known parameter lies in the correct interval.) 

 
 Suppose instead you know from the literature that there is a relationship between 

the losses k(0,1) and k(0,2). For example, suppose k(0,1)=a*k(0,2) where a is 
known. You can enter this information in your model. The result will be that the 
number of parameters to estimate is 4 and your model is identifiable. 

 
 How to do this when a is assumed to be equal to 3 is explained below. 
 

a. Be sure the Experiment tools are available. Double-click k(0,1) to open the 
Loss Attributes dialog box. 

 
b. In the Equations pane, type “k(0,1)=a*k(0,2)”. The Loss Attributes dialog 

box will appear as follows: 
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c. Click Done. 
 
d. Open the Parameters dialog box. Enter “3” as the Value for a, and fix it. 

Enter “0.001” as an initial estimate for k(0,2); set k(0,2) as an adjustable 
parameter. The Parameters dialog box will appear as follows: 
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 Click Done. 
 
e. Fit the model to the data. When you view the solution, you will see from the 

plot that the fit is the same as all others you have obtained in this part of the 
case study. When you view the statistical information, you will see that the 
error estimates for the parameters are fine also.  

 
What you should also notice is that while the values of the rate constants are 
changing, the value of the objective function is remaining essentially the 
same. This illustrates the multi-solution nature of the general two-
compartment model. 

 
If you wish, you can record the results in the Notes window with the heading 
“Best fit of the model to the data with k(0,1) = 3*k(0,2).” If you do not record 
your results, you may proceed to step 14. Your Notes window will appear in 
part as follows: 

 

 
 

 Close the Notes window. 
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14. Using Bayesian parameters. 
 
 Suppose you know that there is a relationship between k(0,1) and k(0,2), but you 

do not know it precisely. In the above, for example, suppose you know that k(0,1) 
= a*k(0,2), but instead of knowing that a is precisely 3, from the literature you 
know that a is approximately 3 with a standard deviation of 1. The question is 
how to incorporate the uncertainty about a into the model. This is done in SAAM 
II by using the Bayesian option. 

 
a. In the Compute menu, click Settings. The Computational Settings dialog 

box will open. 
 

(1) Select the Include Bayesian Term check box. The Computational 
Settings dialog box will appear as follows: 

 

 
 
(2) Click Done. 
 

b. Open the Parameters dialog box. 
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(1) Be sure a is selected (if it is not, double-click a to select it.) 
 
(2) Select the Bayesian option. 
 
(3) Enter: “3” in the Value box. 
  “1” in the Low Limit box. 
  “5” in the High Limit box. 
  “3” in the Mean box. 
  “1” in the SD box. 
 
(4) Click Save.  
 
(5) Set the initial estimates for the other parameters as shown in the 

Parameters dialog box as follows: 
 

 
 
(6) Click Done. 
 

c. Solve the model, and view the solution. It is reasonable. 
 
d. Fit the model to the data, view the solution and statistics. The solution in 

terms of the plot is the same as for all other successful “Fits.” The Statistics 
window will appear as follows: 
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 Now even though the “Fit” is identical to the rest, the statistical information is 
different. The reason is the addition of the Bayesian parameter a. This adds 
some uncertainty that was not present before. This is reflected in the 
uncertainties in the rate constants which are a little higher than in the previous 
fits. 

 
e. If you wish, you can record the results in the Notes window with the title 

“Best fit of the model to the data with k(0,1) = a*k(0,2) where a=3 is Bayesian 
with SD = 1.” If you do not record your results, Quit the SAAM II 
Compartmental application.Your Notes window will appear in part as shown 
below: 

 

©University of Washington Hyrdomorphone - 37 Rev. 08/10/01 



Pharmacokinetic Case Study Hydromorphone IV Kinetics 

 
 

If you wish, you may save this study file for future use. For convenience, the contents of 
the Notes window are included in Appendix 2; this should help you review the modeling 
analysis you have just completed. 
 
Quit the SAAM II Compartmental application. 
 
Essential Points to Remember 
 

• Both the compartmental and non-compartmental pharmacokinetic parameters 
for the two-compartment model can be obtained from the compartmental 
analysis using standard equations. 

• The AUC option in SAAM II enables the area under the curve to be calculated 
for any compartment, but the length of the experiment must be increased to 
ensure all of the area is estimated. 

• Parameter identifiability limits the number of parameters that can be specified 
for a given compartmental model. As a general rule, the number of 
compartments in a model cannot exceed the number of exponential phases in 
the data, and the number of model parameters cannot exceed the number of 
exponents and coefficients in the multiexponential describing the data. 
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Appendix 1: Obtaining Initial Parameter Estimates 

for the Two-Compartment Model (Two-Exponential Model) 
 
The key to understanding how initial parameter estimates can be obtained for the two-
compartment (or two-exponential) model lies in understanding the notion of half-life. The 
half-life is defined as the time it takes for one-half of the material remaining in a system 
to irreversibly leave the system.  
 
In this appendix, it is assumed that you have worked through the appendix explaining 
how to obtain initial parameter estimates for the one-compartment model; this appendix 
follows the case study on cadralazine kinetics. The ideas presented in this appendix 
extend those presented for the one-compartment (one-exponential) model. In this 
situation, unlike the one-exponential case, the data following the bolus injection into 
plasma do not appear as a straight line when plotted semi-logarithmically. However, as 
will be seen, the biexponential decay is a combination of two monoexponential decays. 
 
In this appendix, you will learn how to obtain the initial estimates in the following two 
situations: 
 
• bolus injection of drug into plasma, and serial plasma samples taken; and 
• constant infusion of drug into plasma, and serial plasma samples taken. 
 
The bolus injection will be discussed first. Three different techniques that can be used to 
obtain initial parameter estimates will be discussed. 
 
To begin, some information concerning the structure of the general two-compartment 
model and sums of exponentials is necessary. The general two-compartment model is 
given below: 

 
Model 1. The general two-compartment model with five parameters. 

 
If the sample equation s1 is given by s1=q1/vol, then there are five parameters in this 
model: vol, k(2,1), k(1,2), k(0,1) and k(0,2). If the input into Compartment q1 is a bolus, 
then it is known that the solution to the system of differential equations represented by 
the model is an expression of the form: 
 

 tata eAeA
vol
qts 21

211
1)( −− ⋅+⋅==  (1) 
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while if the input into compartment q1 is a constant infusion, the solution is: 
 

 01)( 2102101
21 =++⋅+⋅+== −− AAAeAeAA

vol
qts tata  (2) 

 
For both sums of exponentials, there are four parameters:  A1, A2, a1 and a2. This is true in 
the case of (2) because of the equation constraining the sum of the parameters equal to 
zero. 
 
It is known that for a data set that is biexponentially decaying (i.e. following a bolus 
injection) or biexponentially rising (i.e. following a constant infusion) that the four 
parameters of the exponential model are unique (called a priori or uniquely identifiable). 
However, the five parameters of the general two-compartment model are not uniquely 
identifiable. In this case, there are an infinite number of solutions. Why is this the case? 
 
The reason why this is the case comes from the relationship between the A1, A2, a1 and a2 
and the vol, k(2,1), k(1,2), k(0,1) and k(0,2). This is important since it provides the 
equations by which the initial parameters for the two-compartment model can be 
obtained. The relationship comes from a priori identifiability analysis [2]. 
 
The relationship for the bolus injection is the following: 
 

 

21

2
21

2
2121

21

2112

21

2211

)(
)()1,2()2,1(

)2,2(

)1,1(

AA
dvol

AA
aaAAkk

AA
aAaAk

AA
aAaAk

+
=

+
+⋅⋅

=⋅

+
⋅+⋅

=

+
⋅+⋅

=

 (3) 

 
where k(1,1) = k(2,1)+ k(0,1)  and k(2,2) = k(1,2)+ k(0,2) , and d is the amount in the 
bolus. Thus the parameters that can be uniquely identified as vol, k(1,1), k(2,2) and the 
product k(1,2)k(2,1). The relationship for the k(i,j) is the same for the constant infusion 
experiment; the expression for vol is different as discussed below. 
 
If the general two-compartment model is not uniquely identifiable, what about the 
commonly used two-compartment model shown as follows: 
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Model 2. The two-compartment model with no loss from compartment 2. 
 
In this case, there is no loss k(0,2). This means k(2,2)=k(1,2). Since k(2,2) is uniquely 
identifiable and since it now equals k(1,2),  k(1,2) uniquely identifiable. Since the product 
k(1,2).k(2,1) is identifiable and k(1,2) is known, one can solve for k(2,1) making it 
uniquely identifiable. Since k(1,1)=k(0,1)+k(2,1), and k(2,1) is known, one can solve for 
k(0,1) making it uniquely identifiable. Thus the parameters for the two-compartment 
model, Model 2, are uniquely identifiable, and can be obtained directly from the 
coefficients A1 and A2 and exponentials a1 and a2 of the sum of two exponentials using 
(3). 
 
In what follows, initial parameter estimates for Model 2 will be discussed for the bolus 
and constant infusion inputs. 
 
Part 1. Bolus injection into plasma 
 
Three methods to estimate k(2,1), k(1,2), k(0,1) and vol will be given. The formal curve 
peeling method, as discussed in [1], will be given first. This is somewhat tedious, so two 
quicker methods will be discussed. If neither of these quicker methods work, you can 
always rely on the formal curve peeling method. 
 
If you plot the hydromorphone data in semi-log form, you will obtain the following: 
 

 
 
The left plot shows the all of the data. Since the initial decay is very rapid, it is useful to 
expand this portion of the plot. The right plot shows the initial decay to 20 minutes. It is 
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interesting to note that the break in the curve occurs at about 5 minutes. Thus if one 
waited until 5 minutes or later to draw the first plasma sample, the data would decay 
monoexponentially. 
 
 Curve Peeling
 
Following the description in Chapter 3 of [1], the first step in formal curve peeling is to 
draw a line through the final decaying portion of the data making sure this line is 
extended to intersect with the y-axis. This is shown in the following figure: 
 

 
 
Note the intersection of this line with the y-axis, as shown in the following figure, is 8. 
This provides an estimate for A2. You can now calculate the half-life of the terminal 
slope. This is shown in the following figure as the time it takes to go from 6 (at about 85 
minutes) to 3 (at about 275 minutes) which is approximately 190 minutes. The half-life is 
thus ln(2)/190, or 0.0036. This provides an estimate for a2. Thus we have the second term 
of (1): 
 
   (4) tta eeA ⋅−− ⋅=⋅ 0036.0

2 82
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t
1/2

6

3

Intercept = 8.0

 
 
The next step is to subtract this amount from each datum. The point is that s1(t) will 
describe each datum. Since s1(t) is a sum of two exponentials, both exponentials will 
contribute to the datum. Thus for the ith datum, . In formal curve 
peeling, the contribution of the second exponential, , is subtracted from each 
datum. For this example, the results are shown below: 

ii tata
i eAeAts 21

211 )( −− +=
taeA 2

2
−

 
t plasma plasma - 8exp(-0.0036*t)

0.95 47.0 39.0
2.03 32.8 24.9
3.20 16.6 8.7
5.00 10.0 2.2
7.30 8.5 0.7
9.83 8.3 0.5
15.00 7.7 0.1
20.05 7.1 -0.3
30.82 7.1 -0.1
45.90 6.6 -0.1
63.25 6.5 0.1
90.00 5.7 -0.1

123.23 4.8 -0.3
187.00 4.1 0.1
240.00 3.4 0.1
300.00 2.7 0.0  

 
Again, remembering the model is 
 
  (5) tata eAeAts 21

211 )( −− ⋅+⋅=
 
the result of this subtraction is a set of modified data that can be described by the first 
exponential: 
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  (6) taeAts 1

1
mod
1 )( −⋅=

 
That is, if you plot the modified data given in the previous table, the initial portion should 
decay monoexponentially. 
 
Why just the initial portion?  The reason is the term  decays rapidly and hence its 
contribution to the data in the tail portion of the curve is much, much less than . 
That is, in the tail portion of the curve, numerically  is much smaller than . 
Since  predominates in the tail portion, after a certain point you would expect the 
modified data to be near zero, and be both positive and negative. This is exactly the case 
as you can see in the previous table. 

taeA 1
1

−

taeA 2
2

−

taeA 1
1

− taeA 2
2

−

taeA 2
2

−

 
If you now plot the modified data, you will obtain the following: 
 

 
 
This plot is not informative since the initial decay is rapid. If the modified data are 
plotted with a 20 minute time scale, you will obtain the following: 
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Now you see the initial data do appear to decay monoexponentially. You can now repeat 
the above process to obtain estimates for A1 and a1. This is shown in the following figure: 
 

t 1/2

20

Intercept = 80.0

 
 
The intercept of the tangent line is at 80. This provides an estimate for A1. The half-life, 
here measured as the time to go from 20 to 10, is about 1.2 minutes. Thus an estimate for 
a1 can be obtained from ln(2)/2 which is 0.58.  
 
If you are using (1) as your model, these will provide the initial estimates for the model 
parameters A1, A2, a1 and a2. If you are using Model 2, estimates for the rate constants 
and volumes can be found using (3): 
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The dose is 1,504,000ng. Hence an estimate for vol can be obtained as follows: 
 

 17090
88

1504000
==vol  (8) 

 
If you put these initial estimates into your model and Solve, you will obtain the following 
solution: 
 

 
 
These estimates are clearly satisfactory. 
 
 Quick Curve Peeling
 
There is a quicker method to obtain the initial parameter estimates that avoids the formal 
subtraction of  from the data.  taeA 2

2
−

 
The first step is to draw the line through the final decay, and estimate A2 and a2 as above; 
it will be exactly the same. Then, rather that subtracting this component from each datum, 
you can simply draw a tangent line through the initial decay. In this case, you can 
estimate the half-life but the intersect with the y-axis will be A1 + A2 instead of A1. 
Knowing A2, you can obtain an estimate for A1 simply by subtracting A2 from this 
intercept. 
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Since the initial decay is so rapid it is difficult to estimate on the full scale. It is more 
convenient to use the expanded scale from 0 to 20 (for example) shown in the following 
figure. Estimating A1 + A2 and the half-life are shown in the following figure: 
 

 
 
The intercept of 90 gives an estimate for A1 + A2. Knowing an estimate for A2 is 8, an 
estimate for A1 is 82. The estimate of 0.0036 for a2 is obtained as described previously.  
 
From the above, you can see that the half-life of the initial decay is about 1.3 minutes 
(slightly longer than the formal method because  has not been subtracted from the 
data.) An estimate for a1 is thus ln(2)/1.3 or 0.53. The rate constants can be estimated: 

taeA 2
2

−
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and 
 

 16710
90

1504000
==vol  (10) 
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These estimates are a little different from the formal curve peeling method, but they are 
close enough to begin your modeling exercise. 
 
Technical remark: 
 
There are many different kinds of biexponentially decaying data. They range from data 
such as the hydromorphone whose initial decay is extremely rapid followed by a long, 
well-defined final decay, to data which display a very subtle biexponential nature. The 
subtle biexponential nature means it is difficult to be sure there is actually a second 
exponential in the data. At the extremes, one has to be aware that curve peeling, either 
formal or quick, may produce estimates for A1, A2, a1 and a2 that are very sensitive to 
how you draw your tangent lines. While you will produce estimates of these parameters, 
it could turn out that one of the k(i,j), especially k(0,1), may end up with a negative value. 
If this happens, you need to revisit your tangent lines, especially the one characterizing 
the initial decay. 
 
End of technical remark: 
 
 A Quick Method
 
There is a quick method that can be used that doesn’t involve curve peeling. However, it 
does not always produce satisfactory estimates, and you may have to resort to one of the 
two curve peeling methods. It also requires some experience in using the method since in 
many cases, you will have to adjust some of the parameters before proceeding with your 
modeling exercise. But it is quick, and provides insight into which model parameters 
affect different parts of the model predicted curve. 
 
The idea is the following. You can look for the time at which the break in the curve (data) 
occurs, and use the inverse of that number as initial estimates for all the k(i,j) of the two- 
compartment Model 2. 
 
If you look at the original data, reproduced in the following figure on an expanded scale, 
you will see the break in the curve occurs at about 5 minutes. The reciprocal is 0.2, so 
you can use this value as the estimate for the rate constants.  
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There are two different methods to estimate vol. One is the previous method where you 
can extrapolate the initial decay to time zero. The other is simply to use the first datum; 
this assumes that the first datum is representative of the zero-time extrapolation. For the 
latter, remembering the dose is 1504000ng and the first datum is 47ng/ml, an estimate for 
vol is 32,000 (you should note this is very different from the estimates above; this is 
because the initial decay is extremely rapid in this example meaning the estimate based 
on the first datum will be much less reliable than extrapolating to time zero on the y-
axis.) 
 
If you use these initial estimates and solve your model, you will obtain the solution 
shown in the following figure: 
 

 
 
While this does not appear very good, the initial decay does have the characteristics of 
the initial decay of the data. The estimate for vol, which actually scales the model 
predictions, is off by a factor of about 2 (which you can tell by looking where the model 
predicted value intersects the y-axis, and where a line extrapolated through the data 
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would intersect the y-axis.)  Thus change the estimate of vol from 30000 to 15000, and 
re-solve. You will obtain the solution shown in the following figure: 
 

 
 
Obviously the shape of the curve has not been adjusted, but the scale is about right. What 
is happening now between the model predictions and the data is the following: 
 
• The initial decay is not rapid enough. Since k(0,1) partially controls the final decay, 

this parameter cannot be increased. Thus k(2,1) needs to be increased. 
• The final decay is far too rapid. Thus both k(0,1) and k(2,1) need to be decreased. 

Which decreases and by how much depends upon how much material remains in 
compartment 2. It is this compartment that provides the material for the tail portion of 
the curve.  

 
As a rule of thumb, in adjusting the parameters by hand, it is a good idea to adjust one at 
a time rather than in groups. In situations such as the present where the estimates are not 
very accurate, it is best to change them by a factor of no more than 5. As a rule of thumb, 
as the estimates improve, it is best to change them by a factor of 2. This will allow you to 
watch the changes in the model solution, and make better estimates of the adjustments 
you need to make to the parameters. 
 
The following figure shows is result of two simulations. In the first, k(0,1) was reduced to 
0.05 (1/4 of the original estimate), and in the second, k(1,2) was changed to 0.05 (1/4 of 
the original estimate). You can see that there is a substantial improvement. 
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The following is the solution of the model obtained by reducing k(0,1) and k(1,2) to 
0.025: 
 

 
 
While not perfect, the shape of the bend and tail portion is quite reasonable. You might 
try nudging k(0,1) slightly larger, say to 0.03, to see what happens.  
 
To deal with the initial decay, increase k(2,1) from 0.2 to 0.4. The solution you will 
obtain is shown in the following figure: 
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This is certainly good enough to proceed. So from the original quick method estimates 
for the parameters, with 6 simulations you have succeeded in obtaining not only 
reasonable estimates for the parameters, but a knowledge of which parameter affects 
which portion of the curve! 
 
In summary, the steps to obtain the initial estimates for the two-compartment Model 2 
following a bolus injection are 
 
 Formal curve peeling 
 
• Plot the data on semi-log paper. 
• Draw a straight line through the tail portion of the data; extend the line to intersect 

with the y-axis. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a2 in (1). 
• Note where the line intersects the y-axis, this provides an estimate for A2 in (1). 
• Subtract  from each datum. taeA 2

2
−

• Plot the modified data on semi-log paper. 
• Draw a straight line through the initial decay extending is to the y-axis. Where it 

intersects the y-axis is an estimate for A1. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a1 in (1). 
• Estimate the model parameters from (3). 
 
 Quick curve peeling 
 
• Plot the data on semi-log paper. 
• Draw a straight line through the tail portion of the data; extend the line to intersect 

with the y-axis. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a2 in (1). 
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• Note where the line intersects the y-axis, this provides an estimate for A2 in (1). 
• Draw a straight line through the initial decay extending is to the y-axis. Where it 

intersects the y-axis is an estimate for A1+A2. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a1 in (1). 
• Calculate A1 by subtracting A2 from A1+A2. 
• Estimate the model parameters from (3). 
 

Quick method 
 
• Plot the data on semi-log paper. 
• Estimate the time at which the break in the data appears (the move from the 

dominance of one exponential to the second. 
• Calculate the reciprocal of this time. 
• Use this number as estimates for the rate constants k(2,1), k(1,2) and k(0,1). 
• Estimate the volume as the quotient of the bolus dose divided by the first datum or the 

initial tangent line decay value extrapolated to time zero. 
 
To practice the method, you can try exercise 2 in Chapter 3 of [1]. 
 
Part 2. Constant infusion into plasma 
 
The case when the drug is administered as a constant infusion into a two-compartment 
model is not quite as straightforward as the bolus injection. First, the equation for a 
biexponential rise is 
 
  (11) 0)( 2102101

21 =++++= ⋅−⋅−
⋅ AAAeAeAAts tata

 
The counterpart of the curve peeling methods does not apply as described above without 
a preliminary step.  
 
Consider the following data (plotted in semilog and connected using the Line Plot option 
in the View menu) which were obtained following a constant infusion of 400,000 
units/minute for 310 minutes: 
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These data are rising biexponentially to a plateau value. What happens if you subtract the 
plateau value from the data? You will obtain: 
 

  (12) 
tatatata eAeAAeAeAAts ⋅−⋅−

⋅
⋅−⋅−

⋅ +=−++= 2121
210210

*
1 )(

 
since A0 is the plateau value. However, since there is the constraint equation A0 + A1 + A2 
= 0, this will be negative. But 
 
  (13) )()( 21

21
mod
1

tata eAeAts ⋅−⋅−
⋅ +−=

 
will decay biexponentially with a y-axis intercept of –(A1 + A2). This situation will now 
exactly parallel that of the biexponential decay! 
 
Using the data in the previous figure, the following figure illustrates how the plateau 
concentration is estimated: 
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Intercept = 5300

 
 
For this set of data, a plateau value of 5300 is estimated. Subtracting this value from each 
datum, and multiplying the result by -1 gives the following set of modified data: 
 

t plasma -(plasma-5300)
1 111 5189
2 264 5036
3 324 4976
4 391 4909
5 490 4810
6 569 4731
8 763 4537
10 879 4421
15 1210 4090
20 1377 3923
25 1728 3572
30 1815 3485
40 2238 3062
50 2613 2687
60 2829 2471
90 3366 1934
120 4015 1285
150 4446 854
180 4678 622
210 4850 450
240 5214 86
270 5463 -163
300 5319 -19  

 
If you plot the modified data, you will obtain the following figure: 
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It is interesting in that these data might appear to decay monoexponentially. This is an 
example of the more subtle biexponential decay discussed in the technical remark earlier 
in this appendix. In fact if you draw the tangent lines for the quick curve peeling method, 
you will see the biexponential as follows: 
 

 
 
With these modified data, you can proceed to use either the formal or quick curve peeling 
methods to estimate the A1, A2, a1 and a2, and hence the rate constants of the model.  
 
For the volume vol, an estimate is obtained using the equation for the clearance rate CR 
as follows: 
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 5.75
5300

400000
plateau

rateinfusion
===CR  (14)   

 
This is the same equation used in the monoexponential rise. With your estimate for 
k(0,1), 
 

 
)1,0(k

CRvol =  (15)   

 
 A Quick Method 
 
Is there a counterpart to the quick method? The answer is yes, and it works as follows. 
You can estimate where the break in the rising data is (this is somewhat arbitrary); this is 
shown in the following figure: 
 

break

 
 
As indicated in the figure, the break occurs at about 40 minutes. Estimates for the rate 
constants can be obtained from the inverse of 40 which is 0.025. An estimate for the 
volume can be obtained using the equation for clearance rate (14) as described above. 
Using 0.025 as an estimate for k(0,1) in (15), an estimate of 3020 for vol would be 
obtained. 
 
The following figure shows the simulation with k(0,1)=k(2,1)=k(1,2)=0.025 and vol 
equal 3020: 
 

©University of Washington Hyrdomorphone - 57 Rev. 08/10/01 



Pharmacokinetic Case Study Hydromorphone IV Kinetics 

 
 
Clearly these estimates are quite reasonable, and you can proceed with your modeling 
exercise. 
 
In summary, the steps to obtain the initial estimates for the two-compartment Model 2 
following a constant infusion are: 
 
 Formal curve peeling or quick curve peeling 
 
• Plot the data on semi-log paper. 
• Draw a horizontal straight line to estimate the plateau value; extend the line to the y-

axis to obtain an estimate for A0.  
• Subtract A0 from each datum, and multiply the result by -1. 
• Plot the modified data on semi-log paper, and proceed as above with either the formal 

or quick curve peeling method. 
• Plot the modified data on semi-log paper. 
 

Quick method 
 
• Plot the data on semi-log paper. 
• Draw a line to estimate the plateau (this will help in evaluating where the break 

occurs.) 
• Estimate the time at which the break in the data appears. 
• Calculate the reciprocal of this time. 
• Use this number as estimates for the rate constants k(2,1), k(1,2) and k(0,1). 
• Estimate the volume as the quotient of the clearance rate and k(0,1). 
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Part 3. Short infusion into plasma: 
 

In many cases, an intravenous drug dose is not given as a bolus but a short (5 to 60 
minute) infusion. This is used to increase safety by lowering the peak plasma 
concentrations to which the subject is exposed.  In this case, plasma concentrations after 
the infusion is stopped may exhibit a multi-exponential form. The exponents a1 and a2 
can be estimated by either curve peeling method as described in Part 1 for the bolus 
injection data.  A vertical line parallel to the y-axis then can be drawn at the end-infusion 
time and uncorrected intercept estimates made. If the end infusion time is (τ), equations 
developed by  Loo and Riegelman [3] can then be used to “correct” these values so that 
they are the same that would have been obtained had the drug dose been administered as 
a bolus injection: 
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 (16) 

 

where A  1 and A  2 are the uncorrected intercepts measured at the end of infusion 
(infusion time = τ).   
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Appendix 2: Contents of the Notes window for this Case Study 
 
Fit of two-compartment model to data with loss from compartment 1 
   value SD  Coeff Var     95% confidence 
k(0,1)                0.03741  3.27487e-003  8.75485e+000       0.03027       0.04454 
k(1,2)                0.06412  3.26046e-003  5.08528e+000       0.05701       0.07122 
k(2,1)                0.56866  3.87725e-002  6.81826e+000       0.48418       0.65313 
vol               17322.32017  1.38671e+003  8.00535e+000   14300.93684   20343.70350 
--------------------------------- Derived Variables --------------------------------- 
A                    78.89899  6.91409e+000  8.76322e+000      63.83449      93.96349 
AUC                2321.11586  8.10710e+001  3.49276e+000    2144.47749    2497.75423 
AUMC             612400.58681  5.17368e+004  8.44819e+000  499676.01898  725125.15465 
B                     7.92541  1.96436e-001  2.47856e+000       7.49741       8.35340 
Cl                  647.96421  2.26318e+001  3.49276e+000     598.65376     697.27465 
Cmax                 86.82440  6.95060e+000  8.00536e+000      71.68035     101.96844 
MRT_Cpt1             26.73345  2.34047e+000  8.75485e+000      21.63400      31.83290 
Syst_MRT            263.83887  1.36718e+001  5.18189e+000     234.05055     293.62719 
Vss              170958.14482  4.43532e+003  2.59439e+000  161294.42408  180621.86557 
alpha                 0.66658  4.15640e-002  6.23540e+000       0.57602       0.75714 
beta                  0.00360  1.81290e-004  5.03870e+000       0.00320       0.00399 
half_time            18.53022  1.62229e+000  8.75485e+000      14.99555      22.06489 
r                     0.66298  4.15183e-002  6.26235e+000       0.57252       0.75344 
 
                          Objective      Scaled Data Variance 
s1 : plasma            -8.332549e-001       3.291685e-001 
                       -------------- 
Total objective        -8.332549e-001 
 
AIC                     8.148111e-001 
BIC                     9.355281e-001 
 
 
SAAM II AUC calculations 
 
Sample       AUC         Std.Dev. 
------  ------------  ------------ 
s1       2.3211e+003   8.1062e+001 
s2       3.5661e+008   1.8993e+007 
s3       6.1211e+005   5.1697e+004 
 
 
Best fit of model with k(0,2) = 0 
 
   value SD  Coeff Var     95% confidence 
k(0,1)                0.03739  3.27285e-003  8.75375e+000       0.03026       0.04452 
k(0,2)           0.00000e+000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(1,2)                0.06411  3.26014e-003  5.08492e+000       0.05701       0.07122 
k(2,1)                0.56844  3.87544e-002  6.81773e+000       0.48400       0.65287 
vol               17327.35156  1.38688e+003  8.00399e+000   14305.60304   20349.10008 
 
                          Objective      Scaled Data Variance 
s1 : plasma            -8.332469e-001       3.291711e-001 
                       -------------- 
Total objective        -8.332469e-001 
 
AIC                     8.148151e-001 
BIC                     9.355321e-001 
 
 
Best fit of model with k(0,1) = 0 
 
k(0,1)           0.00000e+000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,2)                0.00395  2.04185e-004  5.17069e+000       0.00350       0.00439 
k(1,2)                0.06013  3.15055e-003  5.23959e+000       0.05327       0.06699 
k(2,1)                0.60603  4.14530e-002  6.84004e+000       0.51572       0.69635 
vol               17321.46748  1.38653e+003  8.00467e+000   14300.49046   20342.44450 
 
                          Objective      Scaled Data Variance 
s1 : plasma            -8.330776e-001       3.292268e-001 
                       -------------- 
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Total objective        -8.330776e-001 
 
AIC                     8.148997e-001 
BIC                     9.356167e-001 
 
 
Best fit of the model to the data with k(0,1) = 3*k(0,2) 
 
a                     3.00000   ** Fixed **   ** Fixed **   ** Fixed **   ** Fixed ** 
k(0,2)                0.00304  1.54312e-004  5.07958e+000       0.00270       0.00337 
k(1,2)                0.06107  3.21343e-003  5.26191e+000       0.05407       0.06807 
k(2,1)                0.59699  4.12733e-002  6.91359e+000       0.50706       0.68691 
vol               17320.81535  1.38655e+003  8.00514e+000   14299.77569   20341.85501 
--------------------------------- Derived Variables --------------------------------- 
k(0,1)                0.00911  4.62935e-004  5.07958e+000       0.00810       0.01012 
 
 
                          Objective      Scaled Data Variance 
s1 : plasma            -8.332526e-001       3.291692e-001 
                       -------------- 
Total objective        -8.332526e-001 
 
AIC                     8.148122e-001 
BIC                     9.355292e-001 
 
 
Best fit of the model to the data with k(0,1) = a*k(0,2)where a=3 is Bayesian with SD = 
1. 
 
a                     3.00000  1.19024e+000  3.96746e+001       0.40670       5.59330 
k(0,2)                0.00304  3.24475e-004  1.06849e+001       0.00233       0.00374 
k(1,2)                0.06107  3.32405e-003  5.44303e+000       0.05383       0.06831 
k(2,1)                0.59722  4.26458e-002  7.14077e+000       0.50430       0.69013 
vol               17313.16043  1.42861e+003  8.25156e+000   14200.49962   20425.82125 
--------------------------------- Derived Variables --------------------------------- 
k(0,1)                0.00911  2.80678e-003  3.08088e+001       0.00299       0.01523 
 
                          Objective      Scaled Data Variance 
s1 : plasma            -7.842019e-001       3.497556e-001 
 
Bayesian                1.447731e-013 
                       -------------- 
Total objective        -7.842019e-001 
 
AIC                     8.797788e-001 
BIC                     1.026816e+000 
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Appendix 3: Interval Identifiability of the Two-Compartment Model 
 
The full two-compartment model, i.e. the model with four rate constants k(i,j) and the 
volume parameter vol, used in the last part of this case study, while not uniquely 
identifiable, is an example of an interval identifiable model [1]. It is interval identifiable 
because you can determine the interval in which the parameters must lie in order to 
obtain a best fit of the model to the data. Sometimes this information is of value in kinetic 
studies. 
 
The bounds for the parameters are summarized in the following figure. When k(0,2) is 
zero (its low limit), the maximum values for k(0,1) and k(1,2), and the minimum value 
for k(2,1) are obtained. When k(0,1) is zero (its low limit), the maximum values for k(0,2) 
and k(2,1), and the minimum value for k1,2) are obtained. 
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The bounds for the rate constants k(i,j) are therefore 
 

0 ≤ k(0,1) ≤ k(0,1)max

0 ≤ k(0,2) ≤ k(0,2)max

k(2,1)min ≤ k(2,1) ≤ k(2,1)max

k(1,2)min ≤ k(1,2) ≤ k(1,2)max

 

 
With your knowledge of the permissible intervals, you can now revisit this study and this 
time fix one of the other rate constants. If your fixed value is within the interval, you will 
obtain a “fit;” if your fixed value is outside the interval, you will not be able to obtain a 
“fit.” 
 
1. Cobelli, C., Foster, D., and Toffolo, G. Tracer Kinetics in Biomedical Research. 

Kluwer Academic/Plenum Publishers. New York, NY 2000 
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Data for this case study 
 
The data file for this case study includes the formulas for the noncompartmental 
parameters. 
 
DATA 
# Data following a bolus injection of 1504 mcg of hydromorphone. 
# Units are ng/ml 
# 
(FSD 0.1) 
t plasma 
0.00 n 
0.95 47.0 
2.03 32.8 
3.20 16.6 
5.00 10.0 
7.30 8.5 
9.83 8.3 
15.00 7.7 
20.05 7.1 
30.82 7.1 
45.90 6.6 
63.25 6.5 
90.00 5.7 
123.23 4.8 
187.00 4.1 
240.00 3.4 
300.00 2.7 
END 
# The following is the dose in ng 
CONST dose 1504000 
# 
# The following are the noncompartmental parameter equations 
#Cmax=dose/vol 
#half_time=log(2)/k(0,1) 
#r=sqrt((k(2,1)+k(1,2)+k(0,1))^2-(4*k(1,2)*k(0,1))) 
#alpha=(k(2,1)+k(1,2)+k(0,1)+r)/2 
#beta=(k(2,1)+k(1,2)+k(0,1)-r)/2 
#A=(dose/vol)*((alpha-k(1,2))/(alpha-beta)) 
#B=-(dose/vol)*((beta-k(1,2))/(alpha-beta)) 
#AUC=dose/(vol*k(0,1)) 
#AUMC=(A/alpha^2)+(B/beta^2) 
#Syst_MRT=AUMC/AUC 
#MRT_Cpt1=1/k(0,1) 
#Cl=dose/AUC 
#Vss=Cl*Syst_M 
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